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INTRODUCTION 
 
Prototype, Fusion, and Modeling, LLC (PFM) was invited by the Hobby Center for Public 
Policy (HCPP) to take part in the 2014 Greater Houston Partnership (GHP) Leadership 
Forum.  PFM’s role was to assist the HCPP team by creating a dynamic, interactive, three-
dimensional visualization of key economic variables related to pension liabilities across the 
greater Houston area.  As a result, PFM created the LiabilityView software to meet those 
requirements.   
 
Using principles found in the Department of Defense 5000 Series Directive for Concept 
Exploration [1], the LiabilityView software was developed both as an analysis tool and 
presentation aid.  The tool has very low system requirements.  It will run on machines with 
Microsoft Windows operating systems dating back to the year 2002.  Its interface was 
designed to be understandable to both computer experts and novices alike.  The target 
audience for the application ranges from government officials to the general public. 
 
The LiabilityView software includes a database of 3,456 data items for the cities and counties 
studied.  The data items were selected because they contained information deemed to be 
highly relevant to the issue of pension liabilities by members of the study team with expertise 
on the topic.  The database is stored in a flat file format to preserve the “human readable” 
nature of the records.  Data items that are in the current liability database range in time from 
2000 to 2012 – with forecast data from 2013 to 2017.  The software can readily incorporate 
any new additional data points occurring between January 1, 1990 and December 30, 2021. 
 
Data, not directly generated by PFM, was obtained by a team assembled by HCPP.  The 
source data was provided directly on the internet by the cities and counties themselves.  Data 
for the GIS component of the software was obtained from the Harris County Public 
Infrastructure Department [2]. 
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MAIN WINDOW 
 
The Main Window is the primary display area for the LiabilityView application. An image of the 
Main Window, with all of its default contents, is shown in Figure 1 below.  A key feature of the 
Main Window is the interactive map.  The map presents the major features of the 10-county 
Houston metropolitan statistical area (MSA).  Although it appears similar to a traditional two-
dimensional map, it is actually a three-dimensional geometric model.  Because of the three-
dimensional capabilities, LiabilityView supports a variety of features not possible with 
traditional flat-map software. 
 

Figure 1 LiabilityView Main Window 
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Navigating the LiabilityView Main Window 
 
There are three primary methods of interacting with the LiabilityView program: 

 Mouse Commands 

 Pop-up Panels 

 Menu Bar 
 
Mouse Commands used in LiabilityView are typical of those found in other, well-known, 
software packages.  These commands include:  Clicking the mouse buttons, clicking mouse 
buttons with keyboard keys pressed, and dragging the mouse.  Dragging the mouse involves 
moving the mouse with one of the mouse buttons held down. 
 
Pop-up Panels are sub-windows that appear inside of the Main Window.  They can be 
relocated or hidden from view by the user.  These panels serve a multitude of purposes.  
They can: Change the way the map looks, determine which data items are displayed on the 
map, adjust the timeline to show data items between specific dates, and present detailed 
numerical information to users that require it. 
 
The Menu Bar appears in the upper left-hand side of the Main Window, directly under the title 
bar.  Items under each menu heading can be revealed by clicking the left mouse button on the 
heading.  To pick a revealed item, click it with the left mouse button. 
 
Map Viewing 
 
Map viewing is accomplished through the use of a “virtual camera” which, in many ways, is 
analogous to a film or video camera.  Associated with the camera is a “focal point” at which it 
always looks.  When the application starts, the focal point is at the center of the map.  The 
camera can be positioned and oriented through four primary camera controls as follows: 
 
1.  Aiming changes the location of the focal point.  To aim the camera, place the mouse over 
the desired location marker on the map.  Next, click the right mouse button with the control 
key pressed.  The focal point will automatically update to the new location marker. 
 
2.  Zooming allows the camera to move closer to, or further away from, the focal point.  To 
adjust the zoom (range), drag the mouse forwards and backwards with the right mouse button 
pressed and the shift key held down. The mouse wheel can also be used for zooming. 
 
3.  Panning allows the camera to rotate horizontally (azimuth) about the focal point.  To pan 
the camera, drag the mouse to the left and right with the right mouse button pressed. 
 
4.  Tilting lets the camera rotate vertically (elevation) about the focal point.  To tilt the camera, 
drag the mouse forwards and backwards with the right mouse button pressed. 
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Location Markers 
 
Located near each city or county on the map is a three-dimensional marker, analogous to 
those seen in two-dimensional bar charts.  The markers, collectively, represent all study areas 
and are spatially distributed across the Houston MSA.  The height of each marker is 
determined by the magnitude of the currently selected variable being displayed.  The width of 
each marker is generally related to the population of the area (which is used in per-capita 
calculations).  Each marker has one or more tick-marks along its sides. These marks indicate 
the value of the currently selected variable, which is scaled logarithmically [3] so that all 
markers can be succinctly displayed on the map. 
 
Selection 
 
Users can also get detailed information about liability data in an area via Selection.  To make 
a Selection, point the mouse at the top of a marker on the map.  Then, click the left mouse 
button while pressing the control key on the keyboard.  Markers are the smallest selectable 
area on the map. 
 
Quick Reference Guide 
 
To access a quick-reference guide for viewing and selection controls, choose About from the 
Help menu.
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MENUS 
 

FILE, OPTION, AND HELP MENUS 
 
The File Menu allows the user to perform liability database input and output related tasks.  
Figure 2 has an image of the File Menu which has five items: 
 

Figure 2 File Menu, Option Menu, and Help Menu 
 

   
 

 
Load Data 
 
Selecting Load Data brings up an Open File dialog box that allows the user to select a liability 
database to load.  The default file, “10-county.csv”, can be found in the “data” directory of the 
standard distribution folder.  This file is text based and in a human readable format that can 
be imported into a variety of spreadsheet packages. 
 
Export CSV 
 
Export CSV allows the user to save a Comma Separated Value (CSV) file containing a human 
readable report of all areas for a specific user query.  That query is based on the currently 
selected liability variable and the currently chosen date in the timeline. 
 
Save Snapshot 
 
The user can capture the current contents of the Main Window to a Windows Bitmap image 
file (BMP) by selecting Save Snapshot.  In addition to saving the map, all open panels are 
saved in the capture as well.  A panel not needed in the output image file can be closed and 
hidden from display.  The saved bitmap image can be printed, shared via e-mail, or used with 
other software for further processing/analysis. 
 
Print 
 
The Print menu item captures exactly the same information as Save Snapshot but sends the 
image directly to a printer instead of to a file.  The software will automatically scale the image 
to the printer resolution.  In most cases, however, printing in landscape mode results in a 
better quality hardcopy. 
 
Quit 
The program can be terminated at any time via the Quit menu item.   
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Option Menu 
 
The Option Menu allows a user to enable or disable stippling.  Stippling makes area markers 
semi-transparent.  Disabling stippling can speed up LiabilityView on computers with less 
powerful display hardware, but can also make city and county labels harder to read. 
 
Help Menu 
 
The Help Menu provides a means for the user to get further assistance.  Select About for a 
brief reminder of mouse-based viewing commands or for contact information if further 
technical support is required. 
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LOCATION, TIME, AND QUERY MENUS 
 
Figure 3 is an illustration of the Location Menu, Time Menu, and Query Menu.  The intent of 
the three menus is primarily to provide support for a user who is using the tool as a 
presentation platform.  The idea is to have several events of interest ready to be called upon 
in rapid succession, assisting in situations where a presenter must provide a great deal of 
information in a short time. 
 

Figure 3 Location Menu, Time Menu, and Query Menu 
 

   
 
 
Location Menu 
 
The Location Menu allows a user to set the “virtual camera” focal point to a predefined 
location on the map.  Selecting Default Location restores the view to the center of the 
Houston MSA.  Saved Location is a temporary placeholder for the first user-defined location 
(currently undefined). 
 
Time Menu 
 
The Time Menu gives a user the ability to skip forwards or backwards to preset dates in the 
timeline.  Choosing Default Time resets the current time to the first date supported by the 
software.  Jump to 2001, Jump to 2004, and Jump to 2008, set the timeline to January 1st of 
the years 2001, 2004, and 2008 respectively.  Saved Time is a temporary placeholder for the 
next user-defined time (currently undefined). 
 
Query Menu 
 
The Query Menu allows a user to rapidly set the fields of the Query Panel to a predetermined 
query.  Picking Default Query sets each of the fields in the Query Panel to their default state, 
which is the state the panel is in when the software is first launched from the windows 
desktop.  Saved Query is a temporary placeholder for the first user-defined query (currently 
undefined). 
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PANEL MENU 
 
The Panel Menu allows the user to show panels that are currently hidden from view.  Figure 4 
is an image of the Panel Menu which has four items. 
 

Figure 4 Panel Menu 
 

 
 

 
By default, all panels except for the Info Panel are visible when the program starts.  To hide a 

panel, click the small box ( ) in the upper right hand corner of the panel. 
 
Show GIS Panel 
 
To reopen the GIS Panel, select Show GIS Panel from the Panel Menu. 
 
Show Query Panel 
 
To reopen the Query Panel, select Show Query Panel from the Panel Menu. 
 
Show Timeline Panel 
 
To reopen the Timeline Panel, select Show Timeline Panel from the Panel Menu. 
 
Show Info Panel 
 
To reopen the Info Panel, select Show Info Panel from the Panel Menu, or make a Selection 
with the mouse. 
 
Each panel can be moved around inside the Main Window.  In many cases, panels must be 
moved to uncover parts of the map they obscure.  To drag a panel, place the mouse over the 
panel name and move the mouse while holding down the left mouse button.  For a layout that 
works well, place the GIS Panel in the upper right, the Query Panel in the lower right, and the 
Timeline Panel in the lower left of the Main Window.  Panels will remember their positions 
when hidden. 
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PANELS 
 

GIS PANEL 
 
The GIS Panel allows the user to modify the map displayed in the main window.   Figure 5 is 
an image of the GIS panel which consists of four major components: The Navigation Group, 
the Projection Drop-Down Menu Button, the Marker Type Drop-Down Menu Button, and the 
Height scale/Width scale Drop-Down Menu Buttons. By default, the panel is configured to 
show a perspective projection with a 2:1 height scale/width scale using shapes (cones and 
pyramids) as markers. 
 

Figure 5 GIS Panel 
 

 
 
Navigation Group 
 
As seen above, the Navigation Group allows the user to pan or zoom the view of the map 
without using mouse dragging or the corresponding key combinations.  The red arrows 
perform “pirouette” rotation in the horizontal and vertical plane while the green arrows move 
the user closer to, or farther away from, the focal point on the map. For repeated zooming or 
panning, press and hold the left mouse button over the appropriate arrow. 
 
Projection Drop-Down Menu Button 
The Projection Drop-Down Menu Button, shown in Figure 6, allows the user to select between 
perspective and orthographic projections.  Perspective projection provides a 3-dimensional 
view with distant parts of the map appearing smaller and further away.  Orthographic 
projection yields a traditional top-view, or planimetric, 2-D map display.  Panning is only 
available when perspective projection is used. 
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Figure 6 Projection and Marker Type drop-down menu buttons 
 

  
 
 
Marker Type Drop-Down Menu Button 
 
The Marker Type Drop-Down Menu Button allows the user to choose the type of symbol 
displayed at each area on the map.  The drop-down menu button has four options: Shapes, 
Banners, Cities Only, and Counties Only. 
 
Shapes Marker Type 
 
The Shapes marker type uses cones (for Counties) and pyramids (for Cities) to depict the 
value of the currently selected liability variable at the location of each area studied.  The 
height of the shape represents the log-scaled magnitude of the selected liability variable.  The 
width of the shape generally indicates the log-scaled magnitude of the population in that area 
(for per capita calculations).  The color of the shape provides a quick estimate of how low, or 
high, the value of an area is compared to its neighboring areas.  The scheme is based on a 
“traffic light” model with green used for lower values, red for higher values, and yellow for 
values in-between. 
 
Banners Marker Type 
 
The Banners marker type uses rectangular flags (for Counties) and triangular flags (for Cities) 
to depict the value of the currently selected liability variable at the location of each area 
studied.  The height of the flag pole represents the log-scaled magnitude of the selected 
liability variable.  The length of the flag generally indicates the log-scaled magnitude of the 
population in that area.  The color of the flag is determined by the same traffic light model 
used in the Shapes marker type.  The position of the flag on the flag pole gives a more 
detailed view of how the liability variable changes temporally.  It is handy in situations where 
there is not enough of a magnitude difference, over time, to register a color change on the 
flag.  If the flag is lower on the pole then the liability variable is lower in magnitude and if it is 
higher up the pole the opposite is true. 
 
Cities Only/Counties Only Marker Types 
 
The Cities Only and Counties Only marker types are identical to the Shapes marker type but 
with only one type of area depicted on the map – either cities or counties. 
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Height Scale/Width Scale Drop-Down Menu Buttons 
 
Figure 7 shows the Height Scale and Width Scale Drop-Down Menu Buttons.  The two drop-
down menu buttons are used in combination to make the markers on the map larger or 
smaller.  Their purpose is to increase the visibility of areas on the map under differing viewing 
conditions. 
 

Figure 7 Height Scale/Width Scale Drop-Down Menu Buttons 
 

  
 
 
Scale ratio 
 
Four scale ratios are provided: 1:1, 2:1, 5:1, and 10:1.  A scale of 10:1 tells the software to 
draw the markers ten times larger than normal.  The default value in both cases is 2:1, and a 
value of 1:1 implies a reduction in the default size of the markers. 
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QUERY PANEL 
 
The Query Panel provides the user with options for selecting which liability variables are 
displayed on the map.  An image of the Query panel is illustrated in Figure 8.  The Query 
Panel has three major sections: The Variable Group, the Area Group, and the Legend Group. 
 

Figure 8 Query Panel 
 

 
 
 
The Variable Group 
 
The Variable Group, show in Figure 9, allows the user to select specific liability variables to 
view on the map.  The size and color of each city or county marker will change relative to the 
magnitude of the selected variable and the date chosen in the timeline.  There are currently 
16 different variables a user can select.  More can be added at a later time, if necessary.  The 
scroll bar at the right-hand side of the Variable Group can be used to expose variables not 
currently visible in the window. 
 

Figure 9 Variable group 
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The Area Group 
 
The Area Group, shown in Figure 10, lets the user select one of the, currently 12, cities or 
counties for the software to display detailed information about.  Upon selecting an area in the 
Area Group, the map will center on the marker for the desired area.  At the same time, the 
Info Panel will open (if it is not currently open) and specific numbers regarding the query will 
be printed for the user to inspect.  Simultaneously, the other areas on the map will be 
“ghosted” – or made partially transparent-- to allow the user to get a clearer view of the 
target’s marker. 
 

Figure 10 Area group 
 

 
 
 
The Legend Group 
 
The Legend Group, shown in Figure 11, provides information related to the range of data 
values on display to the user.  Its primary purpose is to provide “quick look numbers” showing 
how each area is performing relative to the others.  Variables that are not specifically stated to 
be ratios in the Variable Group will be colored based on their per capita values.  This allows 
the traffic light model used in the legend to assist the user in making apples-to-apples 
comparisons between the different markers displayed on the map. 
 

Figure 11 Legend group 
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TIMELINE PANEL 
 
The Timeline Panel allows users to dynamically display liability data for a specific point in time 
on the map.  This time is known as the “current time”.  By default, the current time is set to the 
first time present in the database.  Figure 12 is an image of the Timeline Panel, which has 
three primary areas of interest: The Date Display, the Tape Deck, and Fine-Tuning Controls. 
 

Figure 12 Timeline Panel 
 

 
 
 
Date Display 
 
The Date Display is visible in the lower right-hand corner of the Timeline Panel.  It shows the 
current date the software is using to select liability data for each area displayed on the map.  
It has the following format: month, day, and year. 
 
The current date is updated by user interaction with the mouse, Tape Deck or Fine-Tuning 
Controls.  The Date Display will rollover if the user attempts to set it to anything beyond 
December 31, 2021.  It will also roll-under if the user attempts to set it earlier than January 1, 
1990. 
 
The user can control forward and reverse playback with the mouse.  Dragging the mouse to 
the left, with the left mouse button down in the main window, controls reverse playback.  To 
drive the timeline forward, drag the mouse to the right in the main window with the left mouse 
button down.   
 
Tape Deck 
 
The Tape Deck derives its name from its similarity to an audio/video cassette player.  It 
consists of a set of three Radio-Buttons and a Timeline Indicator bar. 
 
Radio Buttons 
 
The three Radio-Buttons are mutually exclusive and selecting one will de-select either of the 
other two.  By default, the Pause Button ( ) is selected indicating that playback of liability 
data is halted.  Click the Forward Button ( ) to automatically step forward from the current 
time.  Click the Reverse Button ( ) to automatically step backwards from the current time. 
 
Timeline Indicator Bar 
 
The Timeline Indicator Bar depicts, for the user, where in the timeline the current date falls.  
The user has reached the end of the actual data when the blue bar extends all of the way 
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across its gray container, as shown in Figure 13.  Advancing the timeline forward from that 
point shows data that was generated via forecasting. 
 

Figure 13 Timeline Indicator Bar 
 

 
 
 
Fine-Tuning Controls 
 
The Fine-Tuning Controls are provided so that users can make very specific adjustments to 
the timeline.  They include the Increment Button ( ), and the Decrement Button ( ).  To 
move the year forward by one unit, click on the Increment Button.  To move it backwards by 
one unit, click on the Decrement Button. 
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INFO PANEL 
 
The Info Panel provides detailed information about each selection made by the user.  If the 
panel is not visible when the user makes the selection, it will automatically be displayed.  
Figure 14 illustrates an image of the panel which has three components:  The Text Area, the 
Clear Button, and the Save Button.  Information displayed in the Text Area depends on the 
date chosen in the Timeline Panel and the specific query options enabled in the Query Panel. 
 
 

Figure 14 Info Panel 
 

 
 
 
Text Area 
 
For each selection, and current liability variable, a set of lines are printed into the Text Area: 
1.  A line specifying the current date of the query. 
2.  Lines specifying the aggregate value of all areas studied 
3.  Lines specifying the selected area along with its percentage of the aggregate total.  
4.  A line specifying the per capita value (or ratio for ratio variables) for all areas studied 
5.  A line specifying the selected area per capita value (or ratio for ratio variables) 
 
Data from multiple selections are recorded in the Text Area in the order the selections were 
made.  When the visible portion fills with text, previous data will scroll out of view.  A scrollbar 
will then appear on the right-hand side of the Text Area. 
 
To see results from previous selections, drag the scrollbar upwards with the mouse or use the 
arrow at the top of the scrollbar.  Dragging the scrollbar downwards, or clicking the arrow on 
the bottom of the scrollbar, will bring data from more recent selections back into view.  Making 
another selection will always cause the Text Area to jump back to the most recently printed 
information. 
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Clear Button 
 
The Clear Button removes all selection information from the Text Area, returning it to its 
default state. 
 
Save Button 
 
The Save Button allows a user to save information currently recorded in the Text Area to a file 
on disk.  Both buttons can be used, in combination, to create a simple data file of area liability 
details.  This file can be printed, shared via e-mail, or used with other software for further 
processing/analysis.
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EXAMPLE 
 
Below is an example that is provided to illustrate some of the concepts and graphical user 
interface components previously described in detail.  As can be seen in Figure 15: 
 

 The user has taken a 3-point perspective view centered on Pasadena. 

 The current query looks at “Total Debt/Revenues” for each area. 

 Red markers indicate areas whose debt is > 500% of their revenues and green 
markers are for areas with debt < 275% of revenue. 

 The current date under consideration is 2017, which uses forecast data. 

 Galveston has been selected and specific details relating to its Total Debt/Revenue 
are printed in the Info Panel. 

 
 

Figure 15 Example of output from LiabilityView software 
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